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The Drosophila melanogaster brain comprises different neuronal cell types that
interconnect with precise patterns of synaptic connections. These patterns are
essential for the normal function of the brain. To understand the connectivity
patterns requires characterizing them at single-cell resolution, for which a flu-
orescence microscope becomes an indispensable tool. Additionally, because
the neurons connect at the nanoscale, the investigation often demands super-
resolution microscopy. Here, we adopt one super-resolution microscopy tech-
nique, called stochastic optical reconstruction microscopy (STORM), improv-
ing the lateral and axial resolution to ∼20 nm. This article extensively describes
our methods along with considerations for sample preparation of neurons in
vitro and in vivo, conjugation of dyes to antibodies, immunofluorescence la-
beling, and acquisition and processing of STORM data. With these tools and
techniques, we open up the potential to investigate cell-cell interactions using
STORM in the Drosophila nervous system. © 2021 Wiley Periodicals LLC.

Basic Protocol 1: Preparation of Drosophila primary neuronal culture and em-
bryonic fillets
Basic Protocol 2: Immunofluorescence labeling of samples
Basic Protocol 3: Single-molecule fluorescence imaging
Basic Protocol 4: Localization and visualization of single-molecule data
Supporting Protocol: Conjugation of antibodies with STORM-compatible
dyes
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INTRODUCTION

The nervous system of Drosophila melanogaster is an attractive model in which to
study the molecular mechanisms of neuronal differentiation and proliferation, neurite
outgrowth, synapse formation, and neurodegeneration (Bellen, Tong, & Tsuda, 2010;
Clark, Zarin, Carreira-Rosario, & Doe, 2018; Doe, 2017). In particular, the ability to
express transgenes has facilitated the use of Drosophila in such studies (Venken, Simp-
son, & Bellen, 2011). For instance, in the brain, where many neurites are entangled, it is
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difficult to distinguish a single neurite from others (Scheffer et al., 2020). To resolve each
neurite at high contrast, membrane markers are commonly expressed in small subsets of
neurons in the brain. To this end, it is possible to take advantage of a transgenic fly in
which the transcriptional activator GAL4 is expressed under the control of a cell-type-
specific enhancer (Manning et al., 2012). Complementary to this type of in vivo approach,
one can also employ primary neuronal cultures from the Drosophila brain (Egger, van
Giesen, Moraru, & Sprecher, 2013). The availability of well-defined culture media and
advanced culture techniques makes it possible to dissociate individual neurons and gen-
erate primary neuronal cultures. Primary neuronal cultures have previously been used for
high-resolution imaging of neurite arbors, high-throughput screening of genes for devel-
opmental brain disorders, and cell recording of neuronal activity (Campusano, Su, Jiang,
Sicaeros, & O’Dowd, 2007; Del Castillo, Muller, & Gelfand, 2020; Perrimon & Mathey-
Prevot, 2007). Regardless of which system—in vivo or in vitro—is chosen, analysis of
complex neuron morphologies requires optical resolution below the diffraction limit of
light (<250 nm), as the nanoscopic processes of neurons (e.g., dendrites <250 nm in
diameter) are of high interest for imaging (Lichtman & Denk, 2011). Super-resolution
microscopy techniques provide an excellent solution to this difficulty, improving the res-
olution beyond the diffraction limit (Huang, Bates, & Zhuang, 2009). Although many
techniques have been established for super-resolution imaging of Drosophila samples
(Gao et al., 2019; Jiang et al., 2018; McGorty, Kamiyama, & Huang, 2013; Schnorren-
berg et al., 2016), stochastic optical reconstruction microscopy, also called STORM, is
already widely available and can be used with an extensive array of fluorophores that we
have found appropriate for our needs.

In this article, we provide detailed protocols for preparing Drosophila neurons and taking
STORM images of various structures in the neurons. Basic Protocol 1 describes the es-
tablishment of primary neuronal cultures and the dissection of embryos for immunostain-
ing. To label the neuronal membranes genetically, we take advantage of the UAS-GAL4
system. We start with the appropriate genetic crosses to express membrane markers in
particular neurons and train the adults to lay eggs in their new cages. Once we collect
the embryos, we can either dissociate the embryos to make a primary neuronal culture or
dissect them for in vivo analysis. Finally, we fix the samples before immunostaining, the
approach for which can differ depending on the protein of interest (we discuss the differ-
ence in Basic Protocol 2). For immunostaining and imaging the samples, it is necessary
to choose bright dyes that can overcome reduction of signal due to tissue thickness. In the
Support Protocol, we describe a method of dye conjugation to antibodies for the selected
far-red dye, which is optimal for STORM imaging. Basic Protocol 2 describes the im-
munostaining approach for these samples. Although in vivo labeling is a time-intensive
process, primary neuronal cultures can be labeled and imaged within a couple of hours.
Last, we describe our image acquisition approach in Basic Protocol 3 and our reconstruc-
tion approach in Basic Protocol 4. For STORM imaging, a 647-nm laser line is used to
photo-switch the fluorophores. In this protocol, it is critical to optimize acquisition set-
tings to obtain a high-resolution image. Finally, we describe our step-by-step approach
to reconstructing the STORM data using the ThunderSTORM plug-in in Fiji/ImageJ.

BASIC
PROTOCOL 1

PREPARATION OF DROSOPHILA PRIMARY NEURONAL CULTURE AND
EMBRYONIC FILLETS

STORM has been previously demonstrated on primary neuronal cultures from the rat
cortex (Xu, Zhong, & Zhuang, 2013), which do not require any complex sample prepa-
ration and imaging steps. In contrast, STORM imaging of the Drosophila nervous sys-
tem is challenging. Typically, we use a whole embryo for immunofluorescence imaging
due to the ease of preparation. However, the surrounding tissues and yolk outside the
nervous system provide background fluorescence, which will subsequently degrade theInal et al.
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detection and localization of single molecules, resulting in STORM images with fewer
localizations and worse resolution. To circumvent this, we dissect the embryos in fillet
preparation and remove the intestines and trachea, which contribute to the background
fluorescence. Here, we describe our method for culturing and plating primary cells dis-
persed from Drosophila mid to advanced gastrula embryos and dissecting late embryonic
samples for STORM imaging.

Materials

UAS-myr::GFP flies (Bloomington Drosophila Stock Center, RRID:
BDSC_32197)

elav-GAL4 flies (Bloomington Drosophila Stock Center, RRID: BDSC_8765)
Yeast paste: prepare from active dry yeast (FlyStuff, cat. no. 62-103) by mixing

with distilled water using 1.0 g yeast per 1.5 ml water to create a paste
Grape juice agar plates (see recipe)
50% (v/v) household bleach prepared at 1:1 ratio by mixing in distilled water

(stored away from light)
70% (v/v) ethanol (for culturing neurons)
Concanavalin-A (Con-A; Sigma Aldrich, cat. no. C5275-5MG; for culturing

neurons)
Supplemented SFX medium (see recipe; for culturing neurons)
Phosphate-buffered saline (PBS; for in situ preparation)
Play-Doh modeling clay (for in situ preparation)

Embryo collection cages fitting 60-mm petri dishes
Egg basket, created by cutting a conical tube horizontally and cutting out a circle

from the cap, and then placing a 100-μm nylon mesh filter between the cap and
the tube.

Squirt bottle containing distilled water
Task wipers (KimTech, cat. no. 34155), sterilized
60-mm petri dishes (Corning, cat. no. 430166)
Dissection microscope (Nikon, SMZ-U)
Parafilm (Sigma-Aldrich, cat. no. P7543)
Dumont no. 5 forceps (Fine Science Tools, cat. no. 11252-20)
Coverslip, no. 1.5 thickness (Fisherbrand, cat. no. 12-541B; for culturing neurons)
Imaging spacer (Electron Microscopy Sciences, cat. no. 70327-20S; for culturing

neurons)
Humid chamber or lidded Tupperware with wet tissue (for culturing neurons)
Bunsen burner (for culturing neurons)
1-ml syringe (Becton Dickinson, cat. no. 309659; for in situ preparation)
Double-sided tape (Scotch, cat. no. 665; for embryo alignment and dissection)
Pre-cleaned glass microscope slides 25 × 75 × 1 mm (Fisher Scientific, cat. no.

S13943) with vinyl tape (Scotch, cat. no. 6143; for in situ preparation)
Micropipet puller (Narishige PC-100; for embryo alignment and dissection)
Capillary tubing with outer diameter of 1.2 mm and an inner diameter of 0.6

without filament, as dissection needle in situ preparation and suction needle

Training flies and collecting embryos
1. In an embryo collection cage, cross the GAL4 driver flies with the UAS reporter

flies at 25°C (Fig. 1B, left).

Having a ratio of 1:5 males to females is sufficient for all of the females to lay eggs. A
typical cage containing at least 30-50 adult flies should produce a sufficient number of
eggs.

2. Before the experiment, acclimate the adult flies to the egg collection cage by al-
lowing them to lay eggs for 1-2 days and changing the yeast-streaked agar plates Inal et al.
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Figure 1 Equipment for sample preparation. (A) Tube-connected suction needle. A pipet tip (blue)
attached to the tube is used as the mouthpiece (arrowhead). At the other end of the tube, a dis-
section needle attaches to an adaptor piece (arrowhead). (B) Embryo collection cage with a mesh
top and yeast-streaked plate. The yeast-streaked agar plate is used by flies to lay eggs. (C) Cov-
erslip preparation inside a humid chamber. The double-sided adhesive imaging spacer overlays
the coverslip. Cells should be plated inside the well chamber. (D) Glass slide preparation with a
dissection pool for dissecting the embryos. The embryos (e.g., encircled area) are aligned onto a
piece of double-sided tape and submerged in saline. The dissection pool is created from vinyl tape
on a clean glass slide.

at least once per day. The plates should be changed until flies can synchronously
lay ∼500 eggs per collection period in each plate (Fig. 1B, right).

To prepare yeast-streaked plates, spread a small amount of the yeast paste across the
center of the agar plate in a thin strip ∼1 cm wide; the size of the strip can be increased
for larger amounts of adult flies and/or higher frequency of egg collection.

Keep the cages at 25°C with a humidity of ∼65% in a 12-hr light and 12-hr dark cycle
to facilitate the collection of synchronous embryos.

3. Allow the adult flies to lay eggs on a yeast-streaked agar plate for 1 hr. Collect the
plate from the cage and replace with a fresh yeast-streaked plate.

4. Incubate the plates with the embryos until they reach the appropriate developmental
stage.

Mid-gastrula embryos aged 5-7 hr AEL (after egg laying)—or stage 11 (Campos-
Ortega, 1985)—are ideal for neuronal culture preparation. In our hands, we found that
embryos aged up to 10 hr AEL (i.e., stage 12) can be plated as well.

Inal et al.
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5. Remove the eggshell from the embryos by adding 50% bleach to the embryo-
containing plate for 5 min to allow access to the embryo for cell dissociation and
dissection.

6. Filter the eggs through the egg basket (alternatively, a cell strainer can be used).

7. Wash the filter thoroughly with distilled water so that the embryos are cleared of
chorions and yeast from the plate.

This step is especially critical for cell culture preparation to ensure that there is no
contamination by yeast.

8. Disassemble the egg basket and blot the mesh filter dry with sterilized task wipers.

9. Transfer the embryos into a petri dish by flipping the mesh so that the embryos are
facing the clean plate and washing them into the plate set beneath the filter.

10. Pour the water off the embryos just before collecting.

In the remainder of this protocol, we report two separate methods for in vitro and in
situ sample preparation. In steps 11a-19a, we describe the preparation of primary cell
cultures, and in steps 11b-20b, we describe the preparation of dissected embryos.

Collecting the embryo cell culture
11a. Prepare the plates by laying down a strip of Parafilm on the bottom of a 60-mm petri

dish and covering a section of the plate wall with a damp task wiper. Ensure that
there is enough room to later lay down the double-sided adhesive imaging spacer
(of the appropriate diameter; Fig. 1C).

The strip of Parafilm underneath should roughly be the size of the coverslip plus imaging
spacer. This allows easier removal of the coverslip and imaging spacer from the plate
later.

12a. Using forceps, sterilize the coverslip by submerging it in 70% ethanol and drying
it completely over the Bunsen burner. Lay the sterilized coverslip on top of the
Parafilm strip inside the plate.

13a. Peel the sticker off one side of the spacer and press the adhesive side, facing down,
onto the coverslip. Using forceps, firmly press around the circumference of the
spacer. This prevents any leakage of Con-A or culture medium from the coverslip.

As an alternative, you may skip this step and instead use vacuum grease to mount the
sample as described in Basic Protocol 2, steps 15 and 16.

14a. Spread 10 μl of 0.5 mg/ml Con-A to produce a thin layer on the coverslip. Cover
the petri dish with its lid. Place the dish in a humid chamber with humidity ∼80%,
or a lidded Tupperware container with a wet tissue inside. Incubate for 30 min at
room temperature.

15a. Remove the Con-A from the coverslip. Add 100 μl room-temperature supple-
mented SFX medium to the Con-A-coated coverslip in the plate, working near the
open flame of a Bunsen burner to provide a sterile environment.

16a. Take a dissection needle and break off the tip until the diameter is ∼60 μm, or
about one-third of the embryo’s width, which can be checked in comparison to the
embryos. Connect the needle to one end of the suction tube and add a pipet tip to
the other end to act as a suction source (Fig. 1A).

17a. Examine the embryos, directly from step 10, under the dissection microscope. Use
the pipet tip attached to the tube-connected suction needle (Fig. 1A) to suck and
release the contents of the embryo to break the cells out of the vitelline membranes. Inal et al.
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18a. Transfer the cells from the plate onto the center of the coverslip by gently suctioning
in and out with the tube-connected suction needle; make sure any large clumps are
broken up. Repeat this process until you have dissociated 20 embryos onto the
center of the coverslip.

To prevent contamination, make sure to always place the lid over the plate of your cov-
erslip.

19a. Place the lidded plates into the humid chamber and culture the primary cells for
1-2 days at 28°C.

Aligning and dissecting embryos for in situ preparation
11b. On a glass slide, create a dissection pool using vinyl tape, and place a piece of

double-sided tape inside the dissection pool horizontally to align the embryos
(Fig. 1D).

12b. Collect the embryos at 13-15 hr AEL, at which point they will have four-chambered
gut morphology (i.e., be in stage 16 as described by Campos-Ortega), using forceps,
and place them onto the tape with the dorsal side facing up.

Here we chose to observe embryos at stage 16 because synaptogenesis at the neuromus-
cular junction occurs during this stage; however, it is possible to dissect and image at
older or younger stages as needed.

13b. Add PBS to prevent the embryos from desiccating.

14b. Using a micropipet puller at 12 V, pull the capillary tubing to create a sharp nee-
dle with a taper of ∼0.4 cm in length to serve as a dissection needle. Mount the
dissection needle onto a 1-ml syringe filled with some modeling clay.

15b. Using the newly prepared dissection needle, cut through the midline of the embryo
under a dissection microscope inserting the needle from the surface of posterior
end pushing to the anterior end.

16b. Gently lift the embryo with the needle, which should be slightly underneath the
brain lobes of the embryo, and pull it up and away from the tape.

17b. Reposition the dissected embryo onto the glass slide. Here, the embryos should
adhere to the glass slide by themselves as long as the buffer is not saturated with
proteins and the embryos do not have cuticles.

Please refer to the Commentary and Troubleshooting for further details.

18b. Using the yolk and the intestines that come out as cushion for the dissection needle,
place the epithelial tissues to either side on the glass. With this, there should be
epithelial tissues on both sides of the ventral nerve cord and the brain.

19b. Create another tube-connected suction needle by repeating step 17a. To suction the
internal organs after dissection, the diameter should be ∼300 nm, which is about
the size of the intestines. Using a larger or smaller tip size will change the speed of
suction.

20b. Before moving on to the immunostaining process, clean up the sample by using
a tube-connected suction needle (Fig. 1A) and blowing air or aspirating to detach
and remove the dorsal tracheal trunks and any remaining intestines.

If the saline has a lot of tissues or cells floating around, you can replace it by using
a micropipet to wash the sample with fresh saline to ensure the sample is clear of
debris.

Inal et al.
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BASIC
PROTOCOL 2

IMMUNOFLUORESCENCE LABELING OF SAMPLES

For immunofluorescence labeling of samples, there are a couple of considerations
necessary to obtain the best quality of STORM images. One important consideration
is the fixation approach applied to the samples. As a result of insufficient fixation,
membrane structures and macromolecule architectures can be broken. In order to
avoid this type of artifact, fixation methods for different cellular targets have been
optimized through the use of certain fixatives. For instance, glutaraldehyde (GA)-
based fixation for tubulin is optimal in preserving the microtubule structures, whereas
fixation with paraformaldehyde (PFA) alone is sufficient for preserving membrane
structures. Because of its high resolution, STORM can readily uncover disruptions
resulting from insufficient fixation. Therefore, the choice of proper fixatives is cru-
cial. Next, the density of fluorescent labels should also be considered. When im-
munostaining membrane structures with a membrane marker, the low density of the
marker makes a STORM image discontinuous. With this inadequate labeling den-
sity, it is not easy to evaluate whether the structures are related. Here, we describe
our method for fixing, immunostaining, and mounting the neuronal culture and brain
tissues.

Materials

Drosophila primary culture on coverslip or dissected embryos on glass slide (Basic
Protocol 1, step 19a or 20b)

Phosphate-buffered saline (PBS)
4% (w/v) paraformaldehyde (PFA; Electron Microscopy Sciences, cat. no. 15710)

in PBS
0.1% (w/v) glutaraldehyde (GA; Sigma Aldrich, cat. no. 111-30-8) in PBS
PBS with 0.1% (v/v) Triton X-100 (TBS)
TBS + 0.06% (w/v) bovine serum albumin (BSA; TBSB)
Primary antibodies:

1:200 anti-GFP rabbit monoclonal antibody diluted in TBSB (Thermo-Fisher,
cat. no. G10362, RRID: AB_2536526)

1:200 DM1A anti-tubulin antibody: (Cell Signaling Technology cat. no. 3873,
RRID: AB_1904178)

1:5 anti-HRP antibody: (JacksonImmuno, cat. no. 123-005-021, RRID:
AB_2338952)

Secondary antibodies: 1:200 anti-rabbit IgG secondary antibody conjugated with
Alexa Fluor 647 (AF647) dye (see Support Protocol for dye to antibody
conjugation), diluted in TBSB

Imaging medium (see recipe)

Aspirator (Bio-Rad, Model cat. no. 1651754P)
Orbital shaker (CB, KJ-201BD)
Task wipers (KimTech cat. no. 34155)
Pre-cleaned glass microscope slides, 25 × 75 × 1 mm (Fisher Scientific, cat. no.

S13943)
Vacuum grease or some other spacer to cushion between the coverslip and the

tissues (e.g., Secure Seal Imaging Spacer from Electron Microscopy Sciences,
cat. no. 70327-20S)

Clean coverslip, no. 1.5 thickness (Fisherbrand, cat. no. 12-541B)
Nail polish for sealing the sample

Permeabilization and staining
1. Using an aspirator, remove the culture medium or saline buffer and replace with

4% PFA in PBS for membrane labeling or with 3% PFA+ 0.1% GA in PBS for
microtubule labeling. Inal et al.
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2. Incubate on an orbital shaker to fix for 5 min at room temperature.

3. Wash three times with TBS for 5 min each.

4. Block the sample for 10 min for cell culture (or 1 hr for dissected embryos) at room
temperature using TBSB to reduce or eliminate nonspecific binding of primary and
secondary antibodies.

5. Replace the TBSB buffer with the primary antibody in TBSB.

In some cases, it may be useful to use labeled primary antibodies instead of indirect
labeling with secondary antibodies; please see the Critical Parameters for a discussion
of the advantages and disadvantages of each option.

For primary neuronal culture samples, incubate the primary antibody for at least 1 hr at
room temperature.

For dissected embryo samples, incubate the primary antibody overnight at 4°C.

6. Before staining samples with secondary antibody, remove the primary antibody and
wash three times with TBSB for 5 min each.

7. Dilute the secondary antibody IgG conjugated with AF647 dye to a working con-
centration in TBSB.

8. Exchange the blocking buffer with the secondary antibody using an aspirator. Ensure
that the samples are not dried out during this exchange process.

9. Stain the sample by incubating at room temperature on the orbital shaker for 1-2 hr
for primary neuronal culture samples or 2 hr for dissected embryo samples.

10. Wash the sample three times with TBS for 5 min each.

11. Post-fix the sample using the 4% PFA in PBS for 5 min at room temperature to
crosslink the antibodies strongly and to eliminate floating dyes, which can contribute
to creating background signal.

12. Finally, wash three times with TBS for 5 min each to remove the fixative from the
sample.

Mounting of the immunofluorescence-labeled samples
13. Using task wipers or an aspirator, remove excess buffer from the sample, but ensure

the samples do not dry out.

In case of the in vivo preparation, first remove the tapes that are on the glass slide using
forceps.

14. Exchange the buffer with 100 μl imaging medium.

Make sure to use as much imaging medium as possible to prevent any large air bubbles
from forming in the next step.

15. Mount the coverslip onto the glass slide.

a. To mount cells: Remove the remaining sticker from the spacer, place the glass
slide on top of the spacer, and make sure that it is completely sealed.

Alternatively, apply vacuum grease to each corner of the coverslip and then place the
glass slide on the coverslip.

b. To mount embryos: Place the coverslip on the glass slide, and push it down to
minimize the space between the coverslip and the sample until it touches the CNS.

This will allow maximum brightness of fluorophores during imaging of the tissue sample.

Inal et al.
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16. Remove the excess buffer that has leaked out, seal the edges of the coverslip with
nail polish, and image or incubate at 4°C until imaging.

For optimal results, it is ideal for the sample to be imaged within 3 hr after being mounted
in buffer under minimal oxidation conditions.

BASIC
PROTOCOL 3

SINGLE-MOLECULE FLUORESCENCE IMAGING

In this section, we describe the equipment and steps required for successfully acquir-
ing raw single-molecule data. Although we use a custom-built STORM imaging system
for image acquisition (Fig. 2), one can adopt any of the commercial systems currently
available, e.g., N-STORM (Nikon).

Materials

Lens paper (Thorlabs, MC-5)
Immersion oil (n = 1.52; Cargille, cat. no. 16242)

Custom-built inverted microscope (see also Fig. 2B)
Light source:

405-nm excitation laser (Coherent, OBIS 405 nm LX 100 mW)
561-nm excitation laser (Coherent, OBIS 561 nm LS 50 mW)
647-nm excitation laser (Coherent, OBIS 647 nm LX 120 mW)

Laser control unit:
Arduino Uno
Micro-manager Arduino software (https://micro-manager.org/wiki/Arduino)

Figure 2 Microscopy setup. (A) Schematic of the single-molecule localization microscope. Three
lasers at Wavelengths 647 nm (Coherent, OBIS LX 647-120mW), 561 nm (Coherent, OBIS LS
561-50mW), and 405 nm (Coherent, OBIS LX 405-100mW) are combined with dichroics D2 (Thor-
labs DMLP605T) and D3 (Thorlabs, DMLP425T).Laser line filters are used to filter out spontaneous
emission for the 647 laser (Semrock, LL02-657-12.5) and the 561 laser (Semrock, LL02-561-12.5).
Lenses L2 (Newport, PAC052; efl = 100 mm) and L3 (Opto-Sigma, 026-1132; efl = 120.1 mm) ex-
pand the laser beams to a diameter (1/e2) of 0.96 mm. The excitation beams are then demagnified
by 60× by the tube lens, TL (Olympus, 180 mm), and the objective lens, O1 (Olympus 60×), to
a beam diameter of 16 μm. The emitted light is separated from the excitation light by dichroic D1

(Omega Optical, XF2054, 485-555-650 TBDR). The emission from the sample is imaged on to the
EMCCD Camera (Andor, Ixon-897 Life) first to 60× magnification by the objective lens O1 and the
tube lens TL and then by an additional 2.5× by lenses L3 (120 mm) and L4 (300 mm), for a total
magnification of 150. The camera pixel size is 16 μm, so the effective pixel size at the sample is
107 nm. Two emission filters (Semrock, FF01-446/523/600/677-25 and FF01-680/42) and a notch
filter (Semrock, NF01-488/647) are placed before the camera to block excitation and stray light. (B)
Photograph of the system. The excitation paths and emission path are traced in red, yellow, purple,
and green, respectively.

Inal et al.
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Spectral filters:
Excitation laser clean-up filters: 516 nm (Semrock, LL02-561-12.5)
647 nm (Semrock, LL02-647-12.5)
Dichroic mirror (Omega, XF2054,485-555-650TBDR)
Emission filters: Multi-bandpass (Semrock, FF01-446/523/600/677-25)
Red detection (Semrock, FF01-605/15)
Far-red detection (Semrock, FF01-680/42)
Notch Filters: Red detection (Chroma, ZET561NF)
Far-red detection (Semrock, NF01-488/64)

60× oil-objective lens (Plan Apo N, Olympus, N.A. 1.42)
EMCCD camera (Andor, iXon-897 Life)
Image-acquisition software (Manager 2.0, RRID:SCR_016865)
Computer workstation (Intel Xeon CPU ES-1603 v4, 2.80 GHz, 16 GB RAM) with

a 500-GB solid-state hard drive

Optimizing image acquisition for cell culture and whole-mount immunofluorescence
1. At least 30 min before imaging, turn on the lasers and camera to allow components

to reach a stable operating state.

2. Clean the objective with lens paper.

3. Launch image acquisition software (Manager 2.0) and let the camera temperature
stabilize (to –70°C for the Andor iXon897).

4. Place a drop of immersion oil on the objective lens, and place the glass slide con-
taining the sample in the sample holder with the coverslip facing downwards.

5. Set camera exposure, and use a white light source to bring the sample into focus.

The typical setting for the exposure of an EMCCD camera is 10 ms.

6. Record a single image using the 647-nm laser at an area on the sample where there
are no cells. These images can be used later to subtract the background from the raw
single-molecule data of the respective channels.

7. Using a 647-nm laser, record a wide-field image of the cell with a low laser power
of 1 mW and a short exposure time of 10-20 ms.

8. Using the 647-nm laser, start the STORM imaging acquisition using empirically
derived camera and laser settings. We derive these settings by inversely adjusting
the exposure time and the laser power until the fluorophore emission events were far
enough from each other (sparsely distributed) to be individually identified (Fig. 3A,
top panel). Our typical settings for laser power and exposure time at the beginning
of acquisition were an exposure time of 15 ms and laser power of 30 mW. The frame
transfer mode is set to off in order to reduce noise, and the EM gain is set to 500.
These settings can be found in Micromanager under Devices → Device Property
Browser corresponding to each connected device (i.e., camera and lasers).

We can typically collect at least 40,000 images using the AF647 dye with these settings.
The number of images to collect (i.e., count under “Time Points”) is set in the Microman-
ager acquisition menu with an interval of 0 s.

9. Turn on the 405-nm laser and let it illuminate the sample in continuous-wave (CW)
mode to facilitate regeneration of the fluorescent dye molecules.

At the beginning of data acquisition, set the 405-nm laser power to the lowest possible
setting (1 mW). Increase the laser power of the 405-nm laser by about 5 mW every 5000
frames as the acquisition time increases to record the maximum number of images un-
til all dyes cease to photo-switch. The laser power might increase to 20 mW or more.
The laser power is set in the Micromanager Device Property Browser and can be ad-Inal et al.
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Figure 3 Workflow to detect single molecules and localize the detected molecules. (A) Illustra-
tion of background subtraction (Min) and peak detection (Max). The background intensity was
estimated from an area with no emitting fluorophores (yellow box) using the Measure function in
ImageJ, and the minimum background value was then subtracted from all frames. (B) Demonstra-
tion of fluorophore localization. The image shows the wavelet-filtered image that is used to find
the fluorophores. (C) The image identifies the emitting fluorophores. The local maximum approach
with “8-connected neighborhoods” is used to set parameters.

justed manually during acquisition. The two lasers are controlled by the laser control
unit.

10. After the acquisition ends, the images are available as an image stack in a file in
.tiff format. This file can then be opened in ImageJ or other image-processing
software for analysis.

BASIC
PROTOCOL 4

LOCALIZATION AND VISUALIZATION OF SINGLE-MOLECULE DATA

In STORM, an algorithm is used to precisely measure the positions of single molecules
from raw camera frames. The algorithm has a fundamental effect on the resolution and fi-
delity of the final rendered STORM image. The entire process involved in the rendering of
a STORM image can be divided into five steps: detecting single molecules from raw cam-
era frames, fitting and localizing the detected molecules, processing the positions of these
molecules (e.g., drift correction, density filtering, and intensity thresholding), rendering Inal et al.
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the final image of the molecular localizations, and finally statistically analyzing these
localizations. Many software packages have been developed and published to help non-
expert users perform these steps efficiently. Our protocol below gives a brief description
of how to choose the critical parameters for image reconstruction using ThunderSTORM
(Ovesny, Krizek, Borkovec, Svindrych, & Hagen, 2014), an open-source plug-in for Im-
ageJ. We note that the selected parameters and options described in this protocol are not
the only choices possible. Users should refer to the manual for a detailed guide to select
the proper parameters based on their demands.

Materials

Fiji/ImageJ software (RRID:SCR_002285)
Software for localizing and visualizing single molecules data: e.g.,

ThunderSTORM, RRID:SCR_016897 (use version phasor-intensity-1; Martens,
Bader, Baas, Rieger, & Hohlbein, 2018)

1. Drag and drop the data file collected using 647-nm laser from the file explorer to
ImageJ, or select File → Open in ImageJ, browse to the data file, and press Open.
This will load the entire image stack into memory.

2. Open the dark frame recorded using the 647-nm laser as mentioned in step 1 of
Basic Protocol 3. Using Process → Image Calculator, subtract the dark frame from
the dataset to remove the background (Fig. 3A).

3. Set the camera pixel size in the sample plane, conversion factor between photons
and digital units, base level offset of the camera digitizer, and EM gain of the camera
using Plugins → ThunderSTORM → Camera setup. For our setup, the pixel size
is 107 nm, the gain is 500, and the conversion factor is 4.83 photons/ADU. The
conversion factor and offset are specific to the camera and camera settings and can
be found in the documentation that came with your camera.

Analog-to-digital units (ADU) are the integer values the camera uses to record intensity.
The analog-to-digital converter (ADC) converts the electrons recorded in each pixel into
a digital signal measured in ADUs, which is used to quantify the incident number of
photons per pixel.

4. After opening the dataset, select Plugins → ThunderSTORM → Run analysis. Se-
lect the Wavelet filter (order 3, scale 2) to perform band-pass filtering on the dataset
(Fig. 3B).

5. Under the Approximate localization of molecules tab, select Local Maximum for
Method and choose a peak intensity threshold between 0.5 and 2 times the standard
deviation of the first wavelet level, e.g., 1*std (Wave.F1). If the threshold is set too
low, some additional peaks will be identified due to noise. If the threshold is set too
high, some of the true fluorophores will be missed.

6. Select Phasor-based localization 2D as the method for sub-pixel localization of the
single molecules, with the fit radius being an integer number close to 3 × sigma
(Fig. 3C).

The initial size of sigma can be found by running ThunderSTORM on few images of the
data sequence. A histogram of the fitted sizes of sigma (in pixels) can help to find the
initial value.

7. The localized data can be visualized using averaged shifted histograms, with a mag-
nification of 20 and 4 lateral shifts. Once the parameters for localization and visual-
ization have been set, press OK (Fig. 4A).

8. The order of post-processing steps is specified by the user. However, we recommend
the following order: filtering, density filtering (to remove outliers), and finally driftInal et al.
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Figure 4 Visualization of single-molecule data. (A) Clicking on the visualization button on the
ThunderSTORM results window opens the Visualization window. Set the parameters and click OK
to create the image. (B) The density filter removes unattached fluorophores by removing localiza-
tions that are not close to other localizations and are therefore not part of a structure. Here the
cutoff is 8 localizations within an 8-nm radius. As these numbers increase, more localizations are
removed, which can start to affect continuous structures as well as unattached fluorophores. Left,
ThunderSTORM Density filter window and settings. Right top, image of microtubules before ap-
plication of the density filter. Right bottom, image after application of the density filter. Notice that
there are fewer isolated spots between the microtubules, and the microtubule on the right is less

(legend continues on next page)

Inal et al.
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continuous as well. (C) Drift correction corrects for movement of the sample during data acquisition,
which leads to a blurring of the image. We select the cross-correlation method with the following
settings: number of bins, 5; magnification, 5; trajectory smoothing factor, 1.0. Left, ThunderSTORM
drift correction window and plot of sample trajectory versus frame. Middle, image of microtubules
before drift correction. Right, image of microtubules after drift correction. Scale bar: 0.5 μm.

correction. Typically, we will use the filtering step to remove localizations from the
first frames of the acquisition when too many fluorophores are emitting. Density fil-
tering is used to remove localizations from unattached, isolated fluorophores that do
not label the structure of interest (Fig. 4B). Drift correction accounts for movement
of the sample during the acquisition process.

9. Drift correction by cross-correlation can be performed by clicking the drift correc-
tion tab (Fig. 4C). Typical settings for the parameters are 5 bins, 5× magnification,
and 1.0 for trajectory smoothing. Cross-correlation images with detected peaks can
be viewed by checking the “Show cross-correlations” checkbox to fine tune the pa-
rameters for different datasets. Successful drift correction results in an image with
higher resolution and less blurring: Compare the image before drift correction (mid-
dle panel in Fig. 4C) to the image after drift correction (right panel in Fig. 4C).

10. The output of this process is the table of filtered and corrected localizations and the
final super-resolution figure.

SUPPORT
PROTOCOL

CONJUGATION OF ANTIBODIES WITH STORM-COMPATIBLE DYES

STORM images are constructed based on single-molecule imaging of photo-switchable
fluorescent probes. Compared to labeling for epifluorescence imaging, a single fluo-
rophore emits a weak signal, which makes its detection challenging. Additionally, tissue-
induced spherical aberration and light scattering cause a further loss of fluorescence sig-
nal and thus degrade localization precision (Kamiyama & Huang, 2012). Various bright
probes, including organic dyes and quantum dots, have previously been characterized to
circumvent this problem. Among those probes, Alexa Fluor 647 (AF647; a far-red photo-
switchable dye) is exceptionally bright, producing high-quality images of central nervous
system (CNS) neurons (Dempsey, Vaughan, Chen, Bates, & Zhuang, 2011). Here, we
demonstrate the conjugation of AF647 to antibodies.

Materials

Anti-HRP (JacksonImmuno, cat. no. 123-005-021, RRID: AB_2338952)
Phosphate-buffered saline (PBS)
1 M NaHCO3, prepared from powder (JT Baker, cat. no. 3506-01)
Alexa FluorTM 647 NHS Ester (AF647; Thermo-Fisher, cat. no. A20006) or any

other STORM-compatible dye
Dimethyl sulfoxide (DMSO; Sigma Aldrich, cat. no. 276855)
Secondary antibodies:

Anti-rabbit IgG (JacksonImmuno, cat. no. 711-001-003, RRID: AB_2340584)
Anti-mouse IgG (JacksonImmuno, cat. no. 115-001-003, RRID: AB_2338443)

0.5-ml Illustra NapTM-5 Sephadex columns (20 columns; Cytiva, cat. no.
17-0853-01)

1.5-ml microcentrifuge tubes (for conjugation mixture and for collecting product
fractions)

Aluminum foil
Nutator (BD Clay AdamsTM Nutator Mixer, Becton Dickinson Diagnostics)
Micropipets (Gilson, SKU cat. no. F167380)

Inal et al.
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1. For anti-HRP conjugation, add the following to a 1.5-ml microcentrifuge tube:

60 μl anti-HRP
20 μl PBS
10 μl of 1 M NaHCO3

1 μl AF647 dye dissolved in 10 μl DMSO.

2. For secondary antibody conjugation, add the following to a 1.5-ml microcentrifuge
tube:

20 μl secondary antibody (anti-rabbit or anti-mouse IgG)
60 μl PBS
10 μl of 1 M NaHCO3

6 μl (for anti-rabbit IgG) or 3 μl (for anti-mouse IgG) of AF647 dye dissolved
in 10 μl DMSO.

The stated amount of antibody or dye may not always provide the same degree of label-
ing. These amounts may change depending on the conditions of the ingredients.

3. Cover the tube with aluminum foil to protect it from light.

4. Incubate 15 min at room temperature on a nutator to allow the reaction to take place.

5. During the reaction, wash the Sephadex column three times with PBS at 4°C to equi-
librate the resin pores with PBS, and drain the PBS from the column.

6. After the reaction is finished, slowly add the reaction mixture to the column with a
micropipet.

7. Once the mixture has set into the resin, elute with 400 μl PBS. During AF647 conju-
gation, two bands can be seen forming: the lower band is the conjugated dye, and the
upper band is the unconjugated dyes.

8. Collect the product in 100-μl increments by adding PBS and eluting into different
tubes.

Looking at the color makes it possible to can identify the best-conjugated fraction. Typi-
cally, these are the most dye-concentrated fractions in the middle—i.e., fractions 3 or 4.

UV/Vis absorption measurements can be used to find the degree of labeling.

Using the molar extinction coefficients and the absorptions of dyes at 280 nm, calculate the
degree of labeling. The number of dye molecules per antibody (DOL) should be between
1 and 2 for STORM, and in case of quantitative studies, a DOL closer to 1 is ideal.

9. Store the antibodies up to 1 month at 4°C, or divide into aliquots in small tubes and
store up to 1 year at –20°C.

REAGENTS AND SOLUTIONS

Grape juice agar plates

Prepare agar plates with Nutri-Fly Grape Agar Powder Premix Packets (FlyStuff,
cat. no.47-102) following the provided instructions. Briefly, dissolve one packet
of the powder mix into 500 ml water and bring to a vigorous boil using a
microwave, then let sit to cool. After the temperature of the mixture has
decreased to 70-75°C, pour into 60-mm Petri dishes. Once the agar has
solidified, store plates are at 4°C.

Imaging medium

80 μl phosphate-buffered saline (PBS)
20 μl (w/v) 50% glucose
1 μl 2-mercaptoethanol (Sigma Aldrich, cat. no. M3148) Inal et al.
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1 μl glucose oxidase with catalase, prepared by dissolving 1 mg of glucose oxidase
in 10 μl PBS (100 mg/ml, Sigma Aldrich, cat. no. G2133) and adding 2 μl of catalase
(17 mg/ml, Sigma Aldrich, cat. no. C40) solution.

2-Mercaptoethanol is toxic if inhaled; therefore, it is critical to keep it in a well-ventilated
area and use a fume hood when making the imaging medium.

Typically, when preparing this buffer, we add the catalase to the glucose oxidase solution.
This way, we can store the catalase aliquot of 17 mg/ml in a –20°C freezer for multiple uses in
the future. This buffer should be switched out after three freeze-thaw cycles. Glucose oxidase
with catalase has a much shorter lifespan in 4°C, which should be prepared freshly after 3-4
days.

Supplemented SFX medium

To 9.4 ml HyClone SFX-Insect cell culture medium (Cytiva, cat. no. SH30278.02),
add:

400 μl fetal bovine serum (R&D Systems, cat. no. S11150)
100 μl 100× Penicillin-Streptomycin (R&D Systems, cat. no. B21110)
100 μl Gibco Insulin-Transferrin-Selenium (Thermo-Fisher, cat. no. 41400045)
Divide into 200-μl aliquots
Store up to 12 months at 4°C.

Prepare the medium in the cell culture hood. When handling the medium afterwards (such
as when preparing plates), work near the Bunsen burner to avoid bacterial contamination.
Use deionized, distilled water in all steps and recipes unless otherwise specified.

COMMENTARY

Background Information
Cultured Drosophila neurons have been

used for investigating cytoskeletal dynamics
in neurons, conducting comparative analysis
studies with in vivo experiments, carrying ge-
netic RNAi screening (Mohr, Bakal, & Perri-
mon, 2010), and identifying cell-autonomous
neuronal mechanisms such as membrane
compartmentalization or presynaptic differen-
tiation (Katsuki, Ailani, Hiramoto, & Hiromi,
2009). Although such in vitro approaches play
an important role in revealing cellular pheno-
types, developmental and functional findings
are crucial for understanding neural circuitry
development. To investigate the underlying
mechanisms, we use embryonic motoneu-
rons in vivo (Furrer, Vasenkova, Kamiyama,
Rosado, & Chiba, 2007; Kamiyama & Chiba,
2009; Kamiyama et al., 2015; Sharifai et al.,
2014). This system is amenable to targeted
genetic manipulation in a cell-type-specific
manner, allowing us to study neural specifi-
cation, axon and dendritic guidance, partner
selection, and synaptogenesis. In further-
ing our understanding of synaptogenesis,
the neuromuscular junction serves as an
excellent model system due to the stereo-
typical motoneuron targeting (Keshishian,
Broadie, Chiba, & Bate, 1996). For partner
recognition to result in a mature synapse, the
neuronal growth cone must interact with the

muscle through actin-based hairlike structures
found in both cells (Ritzenthaler, Suzuki, &
Chiba, 2000). These fine structures, called
filopodia, explore the local environments to
match partner cells together (Fig. 5). Although
some developmental time points have been
identified, the nature of the filopodial inter-
actions remains elusive because of their fine
structures. However, the protocol described
here can be further used for labeling the neu-
romuscular junction and applying dual-color
STORM, so that the details of filopodial
interactions can be further investigated.

Here, we demonstrate STORM, which
utilizes photo-switchable organic fluores-
cent dyes to precisely localize individual
molecules. Unlike conventional light mi-
croscopy, STORM can achieve resolutions of
∼20 nm laterally and ∼50 nm axially (Huang
et al., 2009). There have been numerous
examples of the application of STORM to
biological research (Kamiyama & Huang,
2012). In particular, STORM is a valuable
asset for conducting anatomical studies of
filopodia. Because the filopodia are so tiny
(∼200 nm in width and ∼5 μm in length),
their architecture can be characterized through
STORM. Furthermore, we find that multi-
color STORM allows us to visualize filopodia
between the motoneuron and the muscle
(as demonstrated by confocal microscopy;Inal et al.
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Figure 5 In vivo central nervous system. The central nervous system is labeled with anti-HRP an-
tibody (magenta), and a single muscle (M12) is labeled using 2702-GAL4 driver with GFP (green).
The boxed region highlights the neuromuscular junction of the embryo. The right panel shows a
representative growth cone and muscle filopodia interaction during synaptogenesis. Once the ini-
tial contact is made, the filopodia undergo morphological changes by clustering at the synaptic
site to form the synapse. Images were acquired with 10× objective (left) and 100× oil immersion
objective (right). Scale bars: left, 50 μm; right, 5 μm. Genotype: UAS-CD4-tdGFP,2702-GAL4/TM3.

Fig. 5). For this purpose, we have evaluated
many organic dyes at different emissions
(M.A.I., and D.K., unpublished data). Al-
though the dyes are photo-switchable under
specific buffer conditions, Alexa Fluor 647 ex-
hibits the best photo-switching ability. As an
alternative to the STORM technique, multiple
groups have recently developed a new ap-
proach, called DNA points accumulation for
imaging nanoscale topography (DNA-PAINT;
Jungmann et al., 2014; Jungmann et al., 2010).
DNA-PAINT is compatible with the imaging
platform of standard STORM. The approach
takes advantage of DNA specificity for target
recognition using a docking strand of DNA
conjugated to an antibody and an imager
strand of DNA conjugated to a fluorescent
dye. In contrast to the traditional STORM
technique, the blinking effect is achieved by
the transient binding of these DNA strands.
We can apply different orthogonal docking
sequences with unique fluorophores to the
same sample, which allows the observation
of multiple proteins. This approach also
has the potential for multicolor imaging of
Drosophila tissues.

Critical Parameters

Primary neuronal culture
To set up for a healthy neuronal culture,

adult flies in the mating cage should be no
older than 1 week. This ensures healthy
embryos to begin plating neurons. Plating

an appropriate density of cells (∼1.2 × 105

cells/cm2; see also Fig. 6) is key to axonal
growth, secure adhesion to the coverslip, and
reduced clustering and layering. However,
the researcher should keep in mind that too
low a cell density may risk the survival of the
neurons.

Tissue preparation
For embryonic dissection, selection of the

developmental age is important (Inal, Ban-
zai, & Kamiyama, 2020). Beyond the age of
∼15 hr after embryo laying, the embryos will
start depositing cuticles, which will prevent
the embryos from sticking to the glass slide.
Although older embryos can also be dissected,
the method described here may not be ap-
propriate for those experiments. In addition,
the number of embryos that can be dissected
and placed onto the glass slide becomes lim-
ited, as the amount of protein in the buffer
will be saturated and coat the glass, preventing
any more embryos from sticking to the slide.
When washing the embryos after dissection
in the subsequent steps of the protocol, care
should be taken to prevent embryos from lift-
ing off the slide or being destroyed due to sur-
face tension.

Fixation
We usually fix cellular proteins with 4%

paraformaldehyde. In contrast, we use a mixed
concentration of paraformaldehyde and glu-
taraldehyde to preserve microtubule structures

Inal et al.
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Figure 6 Neuronal cell culture expressing GFP on the plasma membrane. The boxed region
details the fine structural components of the neurite. The components such as filopodia and lamel-
lipodia are important in forming mature synapses with their partners. Scale bar: 15 μm. Genotype:
UAS-myr::GFP; elav-GAL4.

(Kamiyama & Huang, 2012). To maintain
cells in their most natural state, we optimize
a fixation approach for the structure of inter-
est. The optimal fixative for the ideal image
should be whatever is best for preserving the
target structure while avoiding structural arti-
facts.

Immunostaining
Because the quality of a STORM image

depends on labeling density, the immunos-
taining needs to provide the best labeling
density to make it possible to take the best im-
age. To achieve this, antibody concentrations
higher than the recommended should be used.
Additionally, longer incubation times allow
more effective labeling. Therefore, if possi-
ble, the primary antibody should be incubated
overnight at 4°C and secondary antibody for
∼1-2 hr at room temperature. Selecting anti-
bodies that are highly specific for the antigens
will minimize nonspecific labeling and back-
ground signals. Furthermore, it may be helpful
to use primary antibodies that are directly con-
jugated with the fluorophore to minimize link-
age error, which results in increased apparent
size of structures (Huang et al., 2009).

Antibody conjugation
The degree of antibody labeling should be

between 1 and 2 for STORM imaging, and
this can be measured using a spectrophotome-
ter with the given calculation approach in the
methods. The conjugation from one batch to
another may not give the same DOL, and even

within the same batch, the labeling efficiency
may vary. In this case, it is advisable to collect
the conjugated mixture in smaller (∼100 μl)
fractions.

Mounting and imaging buffers
During long imaging processes, the pH

value of the buffer decreases as oxygen re-
acts with the oxygen-scavenging component
of the imaging buffer. This can hinder the
photo-switching ability of the fluorophore.
Therefore, the freshest buffer possible should
be used and the oxygen concentration in the
buffer should be minimized by sealing the
sample, which can improve the lifespan of
imaging buffer. Additionally, the fluorophores
may lose photon counts if the sample is far
away from the coverglass. Therefore, the
mounting approach, especially for tissues,
should minimize the distance between the
sample and the coverglass (Dani, Huang,
Bergan, Dulac, & Zhuang, 2010). This will
evidently increase the photon counts and
resolution.

Acquisition
The resolution of an image acquired using

STORM is inversely proportional to the num-
ber of photons emitted by a single molecule
(Huang et al., 2009). Apart from the freshness
of the imaging buffer and the quality of the
dye, the laser power with which the dye is ex-
cited plays a vital role in determining the num-
ber of photons emitted by the dye. Every dye
has a maximum number of photons that it can

Inal et al.

18 of 24

Current Protocols



Table 1 Troubleshooting

Protocol Problem Possible cause Solution

Sample
preparation

Poor neuronal growth
and/or differentiation

Suboptimal
temperature
incubation

Incubate cell culture at a higher temperature
(e.g., 28°C)

Embryo does not stick
to glass slide

Unclean glass slide
Embryo cuticles

Use clean glass slide
Use younger embryos for dissection

Embryo is floating or
destroyed

Sample is exposed
to meniscus of the
buffer

When exchanging buffers, use large volumes
for washes to ensure sample remains entirely
covered and prevent drying

Cells are dispersing or
floating

Pressure from the
objective lens
forcing the cells to
float if the buffer
leaks out

Make sure the coverslip perimeter is well
coated and dried in nail polish
Adjust the objective lens to make sure it does
not compress the coverslip
Minimize the distance between coverslip and
the slide, which will increase the working
distance for the objective lens

Filopodia are moving Poor fixation Increase the fixation time or the concentration
of fixative

Poor signal and/or high
background

Nonspecific labeling Use highly specific antibodies
Increase antibody concentration
Use blocking buffer and/or increase blocking
time

Large distance from
sample to coverslip

Minimize distance from the coverslip by
pressing the coverslip down; if it is not being
imaged, the ventral nerve cord can also be
removed via suctioning after fixation

Inconsistent labeling
efficiency

Variable antibody
degree of labeling

Collect conjugates in smaller fractions and test
degree of labeling

Acquisition Low photon count from
fluorophores

Excitation laser is
not aligned perfectly
through the
objective lens.

Realign the system

Reflectivity of
mirrors in excitation
path is low, causing
loss of laser power
before light reaches
sample

Measure reflectivity of mirrors in the excitation
pathway and change mirrors accordingly; we
recommend using dielectric mirrors for the
highest reflectivities

Fluorophores are not
turning off/blinking

Low laser power Increase the laser power until blinking can be
observed

Buffer is not fresh Make sure the enzymes (glucose oxidase and
catalase) in the imaging buffer are freshly
prepared; imaging buffer has an expiration
period of 2-3 hr

Fluorophores are not
turning on

Fluorophore is
photobleached

Alternatively, use an activation laser such as
UV (405 nm) and increase its laser power

Buffer is not fresh See above about imaging buffer

(Continued)
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Table 1 Troubleshooting, continued

Protocol Problem Possible cause Solution

Post-
processing

Axons appear blurry
once reconstructed

Lateral or optical
drift

Ensure the stage is stabilized before acquisition
Perform drift correction on reconstructed image

Reconstructed image
has too many
localizations

Inaccurate intensity
thresholding

Filter out unwanted molecules by changing the
intensity threshold

Figure 7 Reconstructed super-resolution images of various proteins labeled in primary neuron
culture. (A) Conventional wide-field (left) and super-resolution STORM (right) images of micro-
tubules from primary neuronal cells, immunostained with Alexa Fluor 647. The super-resolution
image is reconstructed from 60,000 acquired frames. The insets show the magnified regions of
the white boxes. (B-D) Neurons immunostained with Alexa Fluor 647 (B and C) or labeled with
tdEos (D). Scale bars: 2 μm. Genotypes: (A) UAS-myr::GFP; elav-GAL4, (B and C) UAS-myr::GFP;
elav-GAL4, and (D) UAS-myr::tdEos; elav-GAL4.

emit (Dempsey et al., 2011), and the number
of photons emitted by a dye is linearly related
to the laser power until it reaches the max-
imum number of photons emitted, at which
point the dye is saturated and the number of
photons emitted remains constant at the max-
imum. Therefore, to achieve the best acquisi-
tion, it is important to excite the sample with
and appropriate laser power sufficient to facili-
tate blinking but not too high that one bleaches
the dye too fast.

Troubleshooting
Table 1 lists problems that may arise with

this procedure along with their possible causes
and solutions.

Understanding Results

Reconstruction of super-resolution images
acquired via STORM

For reconstruction, it is necessary to
consider parameters such as background in-
tensity levels and Min/Max values in selecting

Inal et al.
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Figure 8 Reconstructed super-resolution images of neuronal membranes in dissected embryos.
(A) Conventional wide-field (left) and super-resolution STORM (right) images of motor neuron RP5
in anti-HRP labeled embryos immunostained with AF647. The insets show the magnified regions
of the white boxes. (B) An example of 3D STORM image. 3D reconstructed super-resolution image
of aCC/pCC motoneurons labeled with GFP and immunostained with AF647. The image is recon-
structed from six z-slices that cover a total of 5 μm. The inset shows a hollow cross-section of
the axon from the boxed region. Scale bars: (A) 2 μm, (B) 3 μm. Genotypes: (A) UAS-CD4-tdGFP,
2702-GAL4/TM3 and (B) UAS-CD8-GFP, eve-GAL4RN2.

individual blinking events to achieve the high-
est resolution without compromising the qual-
ity of the reconstructed image. In Basic Pro-
tocol 4 (see also Figs. 3 and 4), we show our
workflow for identifying the optimal param-
eters for our samples. These parameters can
vary between setups, sample types (cultured
neuron vs. in vivo neuron), and even individual
acquisition samples. Although there is no one-
size-fits-all approach, the variability among
acquisition samples is not so significant as to
require testing many different parameters each
time. Therefore, the results of reconstruction
should be easily reproducible among multiple
samples.

STORM imaging of in vitro and in vivo
neurons

We show a conventional wide-field image
of a neuron in culture (Fig. 6) and the recon-
struction of the same neuron using STORM
imaging (Fig. 7). With the protocol we de-
scribe here, we can image not only the mem-
branes of the neuronal cells in culture but also
the cytoskeletal architecture of them. Figure
7A presents images of the microtubules ac-
quired from primary neuronal cultures. As
the inset indicates, each microtubule bundle
can be clearly seen, compared to the inset
of the wide-field image. Figure 7B and 7C
show the results of different approaches for
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labeling the neuronal membrane: using anti-
GFP (expressed on the cell membrane through
UAS-GAL4 system) or anti-HRP (a pan-
neuronal membrane marker) antibodies. Fi-
nally, Figure 7D demonstrates the use of pho-
toconvertible fluorescent proteins, in this case
tdEos, as an alternative means to image the
membrane structures of the neurons. Using
similar labeling approaches, we also apply
these tools to in vivo neuronal imaging. Fig-
ure 8A and 8B show, respectively, neurons
labeled with anti-HRP antibody and neurons
labeled with the UAS-GAL4 system and im-
munostained against GFP with AF647 dye.

Although we demonstrate a limited set of
examples for using these tools, other proteins
can also be imaged with this method using
STORM to individually localize and elucidate
their cellular roles at resolutions of ∼20 nm.
Additionally, other photo-switchable dyes or
fluorescent proteins can be used to look at cel-
lular or molecular interactions in multicolor
STORM imaging.

Time Considerations
Flies need to be trained for 2 days before

primary culture and embryonic sample prepa-
ration. The culturing step for primary neurons
requires an additional ∼2 days to allow neu-
ronal morphology to differentiate before im-
munostaining. However, the embryos can be
collected immediately after the 2-day training
period and dissected. Dissection of embryos
can take as little as 5 min for 10 embryos for
an experienced individual, although a begin-
ner may at first take 5 min or longer to dissect
a single embryo. Depending on the efficiency
of the individual, the number of embryos to
be dissected can be modified, especially for
developmentally time-sensitive experiments.
After the fixation step, which takes 5 min,
permeabilization and blocking take ∼1 hr
and 15 min. This is a good point at which
to pause, if necessary. It is also a good time
to prepare dye-conjugated antibodies, which
can be stored for subsequent experiments.
For indirect labeling, primary antibody incu-
bation takes place overnight and secondary
antibody incubation takes 2 hr. In case of
direct labeling, incubation takes a maximum
of 2 hr at room temperature. The subsequent
washing steps and post-fixation should take
∼25 min.

Image acquisition is controlled by Man-
ager running on a Dell workstation (Intel Xeon
CPU ES-1603 v4, 2.80 GHz, 16 GB RAM)
with a 500-GB solid-state hard drive. Acquir-
ing 40,000 raw frames with a 15-ms exposure

time takes ∼15 min. On the same computer,
the analysis can take up to 20 min, depending
on the number of localizations that are found
and the analysis steps that are used. Opening
the acquired data takes 5 min. The image stack
is then analyzed as described in Basic Protocol
4. Running the analysis in ThunderSTORM
takes 3-4 min. Running the density filter take
3-4 min, and if drift correction is performed,
that will take an additional 5 min. The post-
processing steps must typically be run a few
times to optimize the parameters in order to
generate an optimal final image.
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